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Abstract

The Tomoscope is an online application program which permits bunches to be
visualized in longitudinal phase space and certain beam parameters to be measured
with unprecedented precision.  This note is intended as an introductory guide to using
the Tomoscope to see into phase space at the PS and Booster.  It is available directly
from the application itself by selecting "Read Documentation" from the "Help" pull-
down menu.
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1.  Introduction

The underlying principle of tomography is to combine the information in a sufficiently
large number of profiles to be able to reconstruct unambiguously the fuller picture with the
extra dimension reinstated.  Thus, for example, many one-dimensional profiles of x-ray
transparency taken from different angles can give doctors an image of a two-dimensional slice
through a patient.

The application of tomography to longitudinal phase space becomes obvious once it is
realised that a bunch performing synchrotron motion is analogous to a patient rotating in a
stationary body scanner.  On each turn around the machine, a longitudinal pick-up provides a
“snapshot” of the bunch projected at a slightly different angle.  The acquisition of multiple
profiles of the same bunch, each separated by a few machine turns, is achieved with the
Tomoscope application program.

Longitudinal phase space tomography takes into account the non-linearities of
synchrotron motion by tracking test particles in order to build maps which describe the
evolution of phase space.  The maps are used to reconstruct iteratively a two-dimensional
density distribution whose projections converge towards the measured bunch profiles.  The
reconstruction algorithm can be launched directly from the Tomoscope.

In short, the Tomoscope allows the user to acquire a series of digitized bunch profiles
from which can be generated a two-dimensional picture of how longitudinal phase space is
populated inside the bunch.  The energy distribution of the particles is reconstituted from the
measured bunch shape information.

2.  Getting Started

The Tomoscope application is available from the “Measur” pull-down menu of the PSB
and CPS console managers.  The hardware behind the Tomoscope is simply a digital
oscilloscope that can record multiple traces given a burst of triggers.  A wideband resistive-wall
pick-up provides the input signal.

2.1  PS Version

The mountain range display of Figure 1a shows 60 profiles (“N Traces 60”) of the
same LHC bunch taken every 15 turns (“Delta Turns 15”) of the PS machine.  The first trace (at
the bottom of the mountain range) was recorded 1372 ms (“C Timing 1372”) into the cycle,
while the last trace (at the top) was acquired some 2 ms (“Time span 2.03 ms”) later.

Figure 1b shows exactly the same data after choosing “Oscilloscope” instead of
“Mountain Range” from the “View” pull-down menu.  All traces now have a common vertical
offset and it is apparent that the vertical scale (“V. Scale 0.5 V/div”) has been carefully selected
to use as much of the full digitizer range (10 div) as possible without clipping the bunch peak.
A slight baseline droop during the bunch passage is also evident.  The timebase is controlled as
the product of the time between digitizer samples (“H. Scale 1 ns/pt”) and the number of such
sample points in each trace (“N Samples 500 pts/trace”).  The product of these two parameters
gives the horizontal scale, which can be expanded or contracted about its centre by changing
either of them.  Any desired bunch can be centred in the display by adjusting the horizontal
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offset (“Delay 1020 ns”).  All acquired sample points are always displayed, so any change of
one of the seven ’scope parameters is only apparent upon the next acquisition.

A fresh set of data can be acquired simply by clicking on the “Update” button.  The
next occurrence of the cycle of the current context (e.g., LHC) is then taken.  This is a single-
shot acquisition.  Clicking on the “Unfreeze” button causes the display to be refreshed as
frequently as possible, although this may not be fast enough to capture every occurrence in the
supercycle.  The “Unfreeze” and “Freeze” buttons mutually toggle.

The bunch profiles are not the only data that are acquired each time.  Measurements of
the rf voltage, the harmonic number, the dipole magnetic field and its time derivative are all
obtained from the appropriate 1 kHz samplers at the same timing corresponding to the start of
the bunch data.  These machine parameters may be viewed by selecting “Show Parameters”
from the “Option” pull-down menu.  This produces an additional panel as in Figure 2.

Figure 1a:  Tomoscope mountain range display.
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Figure 1b:  Oscilloscope view.

By clicking on the “Tomogram” button, all the acquired data (together with several
static parameters and some relevant ’scope settings) are piped into the reconstruction program,
which runs on a dedicated workstation.  This is not the end of the story as, when the
reconstruction has finished, the Tomoscope invokes a Mathematica package to process the
results and, finally, a tomogram appears as Postscript graphics on the display.  The process is a
lengthy one and may take up to a minute or so to complete, during which time an indication is
given of how the two main steps of the algorithm – tracking test particles to obtain map
coefficients and iterating those maps to derive the contents of phase space – are progressing.

The use of a tracking code does not mean that the results are simulated.  The
measurement is indirect, but it is nonetheless a measurement.  It’s simply that the physics input
takes the form of a tracking model of the accelerator instead of an algebraic expression.
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Figure 2:  Additional input parameters required by the tomography algorithm.

A great deal of information is provided by the resultant tomogram (see Figure 3).  The
largest plot is a two-dimensional histogram of the contents of phase space with the bucket
separatrix shown in blue.  The associated colour scale appears to the left and the peak charge
density (“1.91E12 e/eVs”) within the bunch is quantified.  The origin of the phase space plot
corresponds to the stable fixed point, but its width is not necessarily the same as the measured
profile duration.  Indeed, it is important that the reconstructed region does not exceed a single
rf period or, more strictly, that the unstable fixed point is not included.  To this end, it is
possible to exclude some of the original sample points by adjusting the “Display Parameters”
cuts (“Lower cut [pts] 100”, “Upper cut [pts] 110”) in the “Tomogram Input” window
(Figure 2).  These cuts are the green lines of Figure 1.  The number of pixels across the
reconstructed image width is given by the number of sample points (500–100–110 = 290)
remaining between the cuts divided by the “Rebinning factor” (290/5 = 58).  The pixel height is
such that small-amplitude trajectories in the reconstructed image are circular.  This aids the eye
to judge the symmetry and matching of the phase space distribution.

The statistical properties of the distribution are summarized in a couple of salient beam
parameters which appear below the plots.  The 1V emittance (“RMS Emitt. = 0.243 eVs”) and
the 2Vp /p relative momentum half-width (“Mom. Spread = 2.27E-3”) are both rms calculations
that are weighted by the individual pixel contents.

The two orthogonal projections of the phase space distribution are plotted in red.  The
integral under these curves – and under the two-dimensional surface – is the same as that under
the measured profile corresponding to the reconstruction time (“Time slice at which to
reconstruct 1”).  The latter profile is shown in black (after rebinning and scaling) for direct
comparison with the projection onto the time axis.
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Figure 3:  Tomogram resulting from the combined data of Figures 1 and 2.

The integral (“Ne = 1.47E12”) and the bunching factor (“BF = 0.306”) of this measured
profile are listed with the other beam parameters.  A foot-tangent algorithm is applied to the
leading and trailing edges of the same profile in order to locate the position of the stable phase
inside the reconstructed image width.  The area (“Mtched Area = 1.19 eVs”) inside the matched
phase space contour passing through both the resultant foot-tangent points is also listed.
Numerical integration around this contour yields the synchrotron frequency (“fs1 = 608 Hz”) at
the edge of the bunch.  The synchrotron frequency (“fs0 = 716 Hz”) at the centre of the bucket
is also calculated.

Finally, in the top right-hand corner, a small plot gives a qualitative idea of how well
the iterations of the reconstruction algorithm converged.  Roughly speaking, one wants to see
this curve descend to less than a third of its initial value.  There is also an echo of the time and
date stamp, the user cycle and of the trigger timing.
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2.2  Booster Version

The PSB Tomoscope is almost identical to the PS one.  However, there is an eighth
’scope parameter to control which of the four rings is acquired and, because of the dual-
harmonic rf system of the Booster, there are two additional machine parameters in the
tomogram input (cf., Figure 4 and Figure 2).  The latter difference would be transparent but for
the fact that no measurement exists of the relative phase between the two rf components.
Consequently, it has to be assumed that this phasing is set up correctly, either with the two
harmonics in phase (short bunch mode) or in phase opposition (long bunch mode).  Since the
latter is the most common, it is the default, but it is up to the user to ensure that the correct
mode is declared before a tomogram is calculated.

Figure 4:  Default tomogram input parameters.

3.  Basic Principles

The Tomoscope settings of Figure 1 were not chosen haphazardly.  They respect the
guidelines shown in Figure 5, which are available from the “Help” pull-down menu under “On
Context”.

Point 0 is merely a reminder that only one instance of the Tomoscope can be running
under a given console manager.  It is, therefore, extremely important always to exit from the
application after use.
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Figure 5:  Criteria for making successful tomograms.

Point 1 is a limitation which is loosely analogous to the Nyquist criterion of
information theory and which is intrinsic to tomography: the data must span at least half a turn
in phase space.  The interval between the first and last profile measurements is itself measured
by the oscilloscope and is highlighted in the display.  The time span (2.03 ms) in Figure 1, for
example, corresponds to a little over one synchrotron period of the bunch in Figure 3 – taking
either the synchrotron frequency at the centre of the bunch (716 Hz) or at its edge (608 Hz).
There is no point in extending the data much further as this would require tracking for longer to
build the maps of the reconstruction algorithm.

Point 2 is a hardware limitation of the oscilloscope: 12.5 Ps is the minimum time
needed to re-arm the trigger.  Cf., the time between consecutive traces in Figure 1 is 34.4 Ps.

Points 2 and 3 are general guidelines to keep the size of the tomography computation
reasonable.  They are not hard limits, but failure to respect them can lead to excessive
execution time or even to a problem of insufficient memory.  Long bunches may be
oversampled then rebinned in order to keep the computation manageable whilst improving the
effective digitizer resolution.

The last point is based on machine physics considerations.  The example of Figure 1 is
taken 2 ms after the injection (at C1370) of the second LHC batch into the PS.  This is
sufficient for the injection bump to have collapsed and, more significantly, for any phase loop
transients to have died away.



8

4.  Reference Datasets

In order to facilitate the task of making routine measurements on operational beams, a
reference dataset containing a set of bunch profiles and the complete state of the Tomoscope
can be saved to disk (using the “Save As…” option of the “File” pull-down menu) for recall
(using the “Open…” option) at a later date.  The “Update” button then permits a direct
comparison with the current status of the beam.

The directories /psb/data/tomo_scope/save/references and /cps/data/tomo_scope/save
/references are accessed by default under the PSB and CPS console managers, respectively.
They contain a subdirectory for each operational user where the .dat files can be stored.  There
is no write protection.

Figure 6:  Rotation of a severely mismatched bunch.
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Figure 7:  Additional input parameters for the bunch rotation case of Figure 6.

For example, the file /cps/data/tomo_scope/save/references/EASTC/br.dat contains the
data shown in Figures 6 and 7.  This is the case of bunch rotation before debunching and slow
extraction of the EASTC beam in the PS.  The first trace was recorded shortly after the return
to the stable phase and the last is at the instant when the rf is switched off 955.7 ms into the
cycle.  The resultant tomogram is shown in Figure 8 and corresponds to the last (green) trace
(“N Traces 87”, “Time slice at which to reconstruct 87”).  This is a difficult case for
tomography as the data span barely more than half a synchrotron period and the information in
many of the profiles is concentrated in just a few sample points.  Consequently, the file br.dat
has been edited by hand to increase the number of iterations to 50 instead of the usual 20.  This
value is static and persists even if the “Update” button is used to get current bunch rotation data
and machine parameters for the EASTC beam.

In fact, there are some 40 input parameters controlling the reconstruction program – not
just the few shown in Figure 7 (or Figure 4 for the Booster).  This is another advantage of the
saved datasets: in addition to their obvious convenience, they permit specialists to tailor some
of the more advanced tomography parameters.  Non-specialists need only load a file and
refresh the data.

The full-blown offline reconstruction program with all its extra bells and whistles is
readily applied to a dataset saved from the Tomoscope.  A /public subdirectory exists at the
same level as /references for anyone to save data which either proved problematic online – in
which case the author is happy to provide assistance – or which require some of the really
advanced features (e.g., space charge) of the offline software.
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Figure 8:  Tomogram resulting from the combined data of Figures 6 and 7.

5.  Strengths and Weaknesses

5.1  Discussion

The greatest strength of the method is its remarkable robustness.  Since the iterations
converge to the consensus of the information in the profiles, trigger jitter and noise in the data
have only a minor effect.  In addition, since the test particles are only tracked for a relatively
brief period to build the maps, moderate errors in the machine parameters used in the tracking
model are not serious.  The result is a distribution which is consistent with all the measured
profiles and the laws of synchrotron motion.  This is considerably better than taking the average
of, say, a gaussian fit to all the profiles – particularly if the bunch is in any way unmatched.
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Much effort has been made to ensure that all the data acquired are coherent.  Even the
time and date stamp, for example, is only updated when the ’scope is triggered; it is not a free-
running clock.  Likewise, since certain combinations of settings cannot be realised by the
hardware, all settings are refreshed to reflect the true state of the ’scope each time an
acquisition is made.

Tests with simulated data have shown that the rms emittance and relative momentum
spread can be accurate to a few percent.  This is far superior to the matched emittance figure,
which is based on one-dimensional information and does not take bunch shape oscillations into
account.  Matched emittance is an acceptance-like concept and is important whenever there are
concerns about particle loss.  Rms emittance is more of a beam quality parameter and affords
precise monitoring of beam dilution irrespective of matching.  For a bunch with perfectly
uniform phase space density, 4 times the 1V rms emittance would contain 100% of an elliptical
distribution, whereas, for a bi-gaussian bunch, 6 times would contain 95% of the population.
Real bunches lie somewhere in between, so the ratio of matched to rms emittance is usually q5.

Figure 9:  Dual-harmonic bunch profiles in ring 2 of the Booster.
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Figure 10:  Additional input parameters for the dual-harmonic case of Figure 9.

The rms momentum spread provided by a tomogram is the best available figure to
subtract out the momentum contribution from a transverse emittance (e.g., flying-wire)
measurement made in a region of non-zero dispersion.

In the PS version of the Tomoscope, only 10 MHz rf parameters are acquired.
Nevertheless, despite the absence of associated samplers, a 40 MHz case can still be treated by
putting in by hand the rf voltage (estimated from the function generator PA.GSV40) and
harmonic number (84) in the “Tomogram Input” window.  In fact, any machine parameter can
be edited prior to launching a tomogram calculation.

Dual-harmonic cases are not considered in the PS version.  It is better to examine the
final product of an rf gymnastic – such as bunch splitting – with a short time span when a
single harmonic has been re-established rather than attempt to treat the full duration of a long
quasi-adiabatic process.  If a tomogram is made when more than one harmonic is present in the
PS, only the largest voltage component is taken into account.

Dual-harmonic buckets are employed routinely in the Booster, but not dynamically as
in rf gymnastics.  Consequently, they are treated in the PSB version since any rf voltage
variations over the time span of the order of a synchrotron period can be neglected.  An
example is shown in Figures 9, 10 and 11.  Here, the second-harmonic component is large
enough to produce inner separatrices within the main bucket.  The rms emittance in this case is
calculated as the sum of three terms: one for each of the three distinct phase space distributions
(see Figure 11), with each term calculated with respect to its own synchronous point.  This is a
more subtle refinement than one might imagine compared to a single-harmonic case where
there is only one centre of motion.
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Figure 11:  Tomogram resulting from the combined data of Figures 9 and 10.

The greatest weakness of the method stems from the fact that it has to rely on one-
dimensional information to estimate the position (on the time axis) of the synchronous point.
This means that bunch oscillations can bias the estimation.  Fortunately, the intrinsic robustness
already mentioned offers plenty of immunity.  One may find that the projection of the
reconstructed distribution is slightly displaced from its corresponding measured profile, but the
reconstruction is normally still valid.  This is readily confirmed by choosing a different “Time
slice at which to reconstruct” such that the bias is reduced.  An almost identical rms emittance
figure should then still be found.

The point is clearly illustrated in the tomogram of Figure 12, which is generated from
exactly the same data as Figure 3 except that the reconstruction is made nearly a quarter of a
synchrotron period later (at time slice 10 instead of the first).  The residual dipole injection
oscillations are responsible for the bias, but the rms emittance calculation is hardly affected.
Note the poorer convergence.
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The bunch oscillations of Figure 1a become even more evident (see Figure 13) by
selecting “Waterfall” from the “View” pull-down menu.  This produces a mountain range as if
seen from above, with instantaneous beam current depicted on a colour scale (and, again, time
increasing from bottom to top).  The dipole oscillations persist because the phase loop can only
damp the aggregate of all bunches and is no longer effective.  It is important to avoid regions
where the phase loop is working hard because its action is not included in the tracking model of
the reconstruction.

Some quadrupolar motion is also apparent.  As with any emittance calculation based on
a single bunch shape measurement, this perturbs the “Mtchd Area”, which differs by 10%
between Figures 3 and 12.  Cf., the rms emittance varies by less than 3%.

Figure 12:  Reconstruction about a slightly biased synchronous point (cf., Figure 3).
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Figure 13:  Waterfall view.

The colour scale of Figure 13 is the same as that used to depict phase space density in a
tomogram.  It has the particular advantage of printing as a continuous grey scale on a black and
white Postscript printer.  It also aids the eye to distinguish the dark core of the bunch and its
yellow tail from everything reddish in between.

5.2  Known Bugs

The tomography algorithm assumes that each trace of the bunch data is triggered with
the same delay with respect to the zero-crossing of the rf in the cavites.  For hardware reasons,
this is not strictly true when the principal harmonic in the Booster is h=2.  Whenever there is no
h=1 component, the revolution train from which the triggers are derived drifts in phase with
respect to the rf buckets in the machine.  However, on the timescale of a synchrotron period,
the drift is slow and so does not preclude successful tomograms.

The Tomoscope application, the tomography code and the Mathematica package all run
on the same dedicated workstation.  A workstation in the control room merely displays the
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resultant windows.  This dissociation would seem occasionally to lead to communication
problems and the application may freeze for up to half a minute.  However, it does not crash.

6.  Maintenance and Support

The online application program was written by Jose-Luis Sanchez Alvarez and is now
maintained by Jean-Francois Comblin.  The tomography algorithm was translated into
Fortran 90 by Mats Lindroos, who still maintains this code.  Steve Hancock maintains the
Mathematica package and can be consulted for user support or to suggest any modifications.

7.  Further Reading

There is no fundamental difference between the online and offline tomography
software.  The former merely exploits a subset of the available features of the same basic
program that has been used extensively long before the Tomoscope became fully operational.
Consequently, the underlying principles of phase space tomography are well documented:

http://cern.ch/tomography/publications.html


